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Appendix S1. Flow diagram for review of protected area checklists in the peer-reviewed literature,

following the PRISMA flow diagram for systematic reviews (Page et al. 2021).
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Appendix S2. List of Web of Science peer-reviewed articles that were evaluated. Arranged by

ascending year of publication and alphabetically by authors.

Authors Country Name of Protected Area Taxonomic group/s
Stalmans et al. 1997 South Africa | Legalameetse Nature Reserve Tracheophyta
Bermingham et al. Honduras Reserva Biologica Cayos Tracheophyta, Insecta,
1998 Cochinos Aves, Mammalia
Eggleton et al. 1999 Guyana Kaieteur National Park Isoptera
Pascarella et al. 1999 | United Everglades National Park Apoidea
States
Rubin et al. 2001 South Africa | The Karoo National Park Tracheophyta
Whipple 2001 United Yellowstone National Park Tracheophyta
States
Danby 2003 United Kluane National Park, Wrangell- Aves, Mammalia
States St. Elias National Park and
Preserve, Glacier Bay National
Park and Preserve, Tatshenshini-
Alsek Provincial Park and Tetlin
National Wildlife Refuge
Wallace et al. 2003 United Great Smoky Mountains National | Membracidae
States Park
Quiroga et al. 2004 Colombia Tayrona National Park Polycladida
Rink 2005 United Canyon de Chelly National Tracheophyta
States Monument
Tufan et al. 2005 Turkey Termessos National Park Fungi
Zomlefer and United Castillo de San Marcos National Tracheophyta
Giannasi 2005 States Monument
Catra et al. 2006 Italy Egadi islands Rhodophyta,
Ochrophyta,

Chlorophyta




Authors

Country

Name of Protected Area

Taxonomic group/s

Dai and Penttila 2006 | China Fenglin Nature Reserve Basidiomycota
Johansen et al. 2007 | United Great Smoky Mountains National | Cyanobacteria,
States Park Charophyta,
Chlorophyta,
Cyanidiophyta,
Rhodophyta,
Chrysophyta,
Prymnesiophyta,
Ochrophyta,
Cryotophyta, Myzozoa,
Euglenophyta
Muise et al. 2007 United Great Smoky Mountains National | Odonata
States Park
Salas-Morales et al. Mexico Huatulco National Park Tracheophyta
2007
Meave et al. 2008 Mexico Yaxchilan Natural Monument Tracheophyta
Nobre et al. 2008 Brazil Catimbau National Park Rhopalocera
Rink and Cully 2008 United Aztec Ruins National Monument Tracheophyta
States
Snyder 2008 United Great Smoky Mountains National | Diplopoda
States Park
Zomlefer et al. 2008 United Cumberland Island National Tracheophyta
States Seashore
De Marinis and Turkey National Park of Termessos Mammalia
Masseti 2009
Hernandez et al. Mexico La Paz Bay and Loreto Bay Decapoda
2009 Natural Parks
Rink et al. 2009 United El Morro National Monument Tracheophyta

States




Authors Country Name of Protected Area Taxonomic group/s
Bora et al. 2010 Madagascar | Tsingy de Bemaraha National Amphibia, Reptilia
Park
Cobanoglu et al. 2010 | Romania Cozia National Park Fungi
Daemane et al. 2010 | South Africa | Golden Gate Highlands National Tracheophyta
Park
Favret et al. 2010 United Great Smoky Mountains National | Aphididae
States Park
Manu et al. 2010 Nigeria Afi Mountain Wildlife Sanctuary Aves
and Cross River National Park
Muelelwa et al. 2010 | South Africa | Blouberg Nature Reserve and Araneae
Western Soutpansberg
Conservancy
Papp and Erzberger Montenegro | Durmitor National Park Bryophyta
2010
Pena-Chocarro et al. | Paraguay Mbaracayu Forest Nature Tracheophyta
2010 Reserve
Romano et al. 2010 Italy Cilento e Vallo di Diano National Amphibia
Park
Zomlefer et al. 2010 United Kennesaw Mountain National Tracheophyta
States Battlefield Park
Arefin et al. 2011 Bangladesh | Satchari National Park Angiospermae
Borges and Machado | Brazil Jau National Park, Rio Negro Aves
de Almeida 2011 State Park, Rio Unini Extractive
Reserve and Amana Sustainable
Development Reserve
Gelder and Williams United Great Smoky Mountains National | Branchiobdellida
2011 States Park

Kraaij 2011

South Africa

Bontebok National Park

Tracheophyta




Authors Country Name of Protected Area Taxonomic group/s
Masroor 2011 Pakistan Margalla Hills National Park Amphibia, Reptilia
Murai and Amr 2011 Syria Al Thawrah Nature Reserve Apoidea
Myers et al. 2011 United Adirondack Park Insecta
States
Cianferoni and Mazza | Italy Foreste Casentinesi, Monte Hemiptera
2012 Falterona e Campigna National
Park
Guareschi et al. 2012 | Spain Sierra Nevada, Cabaneros, Insecta
Ordesa, Picos de Europa,
Aiguestortes and Monfrague
National Parks
Harris et al. 2012 Gabon Loango National Park Tracheophyta
Martinez-Camilo et al. | Mexico El Triunfo Biosphere Reserve Tracheophyta
2012
Schoeman and Foord | South Africa | Marakele National Park Formicidae
2012
Zomlefer et al. 2012 United Chattahoochee River National Tracheophyta
States Recreation Area
Bazairi et al. 2013 Libya El-Kouf National Park Tracheophyta
Bibalani and Taheri Iran Shanjan Rangeland Protected Tracheophyta
2013 Area
Ermilov and Anichkin | Vietnam Dong Nai Culture and Nature Oribatida
2013 Reserve
Ermilov and Anichkin | Vietnam Dong Nai Culture and Nature Oribatida
2013 Reserve
Ermilov and Anichkin | Vietnam Dong Nai Biosphere Reserve Oribatida
2013
Fourie et al. 2013 South Africa | Erfenis Dam Nature Reserve Araneae




Authors Country Name of Protected Area Taxonomic group/s
Moreno et al. 2013 Chile Futangue Park Tracheophyta
Rosas-Espinoza et al. | Mexico Sierra de Quila Protected Area Amphibia
2013
Saarela et al. 2013 Canada Tuktut Nogait National Park Tracheophyta
Siller et al. 2013 Hungary Orseg National Park Fungi
Steyn et al. 2013 South Africa | Tankwa Karoo National Park Tracheophyta
Strazdina et al. 2013 | Latvia Moricsala Strict Nature Reserve Bryophyta
Trilikauskas and Russia Altai Nature Reserve Araneae
Ponomareva 2013
Winfield et al. 2013 Mexico National Park Veracruzan Tanaidacea
Akani et al. 2014 Nigeria Edumanon Forest Reserve Mammalia
Arya et al. 2014 India Madhav National Park Aves
Baard and Kraaij South Africa | Garden Route National Park Tracheophyta
2014
Ciobanu et al. 2014 Chile Ceahlau National Park Tardigrada
Fuentes-Reinés and Colombia Laguna Navio Quebrado Harpacticoida
Suarez-Morales 2014
Hugo-Coetzee 2014 South Africa | Golden Gate Highlands National Oppiidae
Park
Lopez-Pérez et al. Mexico Parque Nacional Huatulco Anthozoa, Asteroidea,
2014 Ophiuroidea,
Actinopterygii,
Chondrichthyes,
Echinoidea,
Holothuroidea
Cardona and Reyes Cuba Baconao Biosphere Reserve Tracheophyta

2015




Authors Country Name of Protected Area Taxonomic group/s
De Liberato et al. Italy Circeo National Park Culicidae
2015
Ermilov and Vietnam Bu Gia Map National Park Oribatida
Bayartogtokh 2015
Langer et al. 2015 Germany Kellerwald-Edersee National Park | Fungi
Machado et al. 2015 Brazil Jericoacoara National Park Gnathostomata
Ouvrard et al. 2015 France Mercantour National Park Psyllidae
Tedrow et al. 2015 Rwanda Akagera, Nyungwe and Mantodea
Volcanoes National Parks and
Arboretum de Ruhande
Tripp 2015 United White Rocks Open Space Nature | Fungi
States Preserve
Venter and Conradie | South Africa | Manubi State Forest and Cape Amphibia, Reptilia
2015 Morgan, Dwesa, Hluleka, Silaka
and Mkambati Nature Reserves
Asem et al. 2016 Iran Urmia Lake National Park Nematoda, Insecta,
Aves, Reptilia,
Platyhelminthes,
Apicomplexa,
Branchiopoda,
Mollusca, Chlorophyta,
Ascomycota, Bryozoa,
Cnidaria, Archaea,
Bacteria
Burner et al. 2016 Malaysia Mount Mulu National Park Aves
Conti and Bartolucci Italy Gran Sasso and Monti della Laga | Tracheophyta

2016

National Park




Authors Country Name of Protected Area Taxonomic group/s
do Carmo and Peralta | Brazil Serra da Canastra National Park Bryophyta
2016
Ermilov et al. 2016 Cuba Alejandro de Humboldt and Valle | Oribatida
de Vioales National Parks
Felix and Massa 2016 | Ethiopia Kafa Biosphere Reserve and Bale | Orthoptera
Mountains National Park
Foord et al. 2016 South Africa | Lekgalameetse Nature Reserve Araneae
Gawor et al. 2016 Vietnam Bai Tu Long National Park Amphibia, Reptilia
Komnenov et al. 2016 | Greece Dadia-Lefkimi-Soufli Forest Araneae
National Park
McCravy et al. 2016 Honduras Cusuco National Park Euglossini
Rodriguez et al. 2016 | Spain Natural Park Serra da Encina da Cyanobacteria,
Lastra Rhodophyta,
Ochrophyta, Myzozoa,
Euglenophyta,
Chlorophyta
Schejter et al. 2016 Argentina Namuncura Marine Protected Porifera, Bryozoa,
Area Brachiopoda, Cnidaria,
Mollusca, Ascidiacea,
Pycnogonida,
Polychaeta,
Osteichthyes
Takiya et al. 2016 Brazil Ubajara and Sete Cidades Insecta
National Parks
Yin et al. 2016 China Nature Reserves in Jiangxi Siluriformes
Province (See Yin et al. 2016)
Aslan et al. 2017 Georgia Lagodekhi National Park Chrysomelidae
Ferreira et al. 2017 Brazil Floresta Nacional de Pau-Rosa Amphibia, Reptilia




Authors Country Name of Protected Area Taxonomic group/s
Larrain and Chile Torres del Paine National Park Bryophyta
Bahamonde 2017
Mustelin et al. 2017 United North-central Olympic National Lepidoptera
States Park
Otero et al. 2017 Morocco Talassemtane National Park Coleoptera
Raimundi et al. 2017 Brazil Serra da Mocidade National Park | Leptophlebiidae
Saarela et al. 2017 Canada Kugluk (Bloody Falls) Territorial Tracheophyta
Park
Urbanavichus and Russia Erzi Nature Reserve Fungi
Urbanavichene 2017
Will et al. 2017 United Great Basin National Park Carabidae
States
Winfield et al. 2017 Mexico Puerto Morelos Reef National Tanaidacea
Park
Atashgahi et al. 2018 | Iran Heydari Wildlife Refuge Tracheophyta
Awang et al. 2018 Malaysia Taman Negara Johor Endau Anura
Rompin
Ayala-Bocos et al. Mexico Cabo Pulmo National Park Gnathostomata
2018
Bego et al. 2018 Albania Korab-Koritnik Nature Park, Rodentia
Lépushé-Vermosh and Bredhi i
Hotovés, Tomorri, Llogara-
Karaburun, Divjaké-Karavasta
and Ligeni i Shkodrés (Skadar
Lake) National Parks
Cortés-Useche et al. Dominican Southeastern Reefs Marine Gnathostomata

2018

Republic

Sanctuary




Authors Country Name of Protected Area Taxonomic group/s
Costa et al. 2018 Brazil Sempre Vivas National Park and Paepalanthus
Serra do Cabral, Rio Preto, Biribiri
and Pico do ltambé State Parks
Crespo et al. 2018 Spain Picos de Europa, Ordesa y Monte | Araneae
Perdido, Aiguestortes i Estany de
Sant Maurici, Monfrague,
Cabaneros and Sierra Nevada
National Parks
de Souza et al. 2018 | Brazil Anchieta Island State Park Gnathostomata
Dippenaar-Schoeman | South Africa | Tswalu Kalahari Reserve Araneae
etal. 2018
Expdsito et al. 2018 Spain Anaga Rural Park Tracheophyta
Haque et al. 2018 Bangladesh | Rajkandi Reserve Forest Tracheophyta
Padiglia et al. 2018 Italy Asinara Island and Capo Caccia- | Porifera
Isola Piana MPAs
Saez et al. 2018 Spain Montseny massif Bryophyta
Sanchez-Jiménez et | Costa Rica | Isla del Coco National Park and Gnathostomata
al. 2018 Las Gemelas Seamount
Sierra et al. 2018 Brazil Jau National Park Bryophyta
Zeng et al. 2018 China Poyang Lake National Nature Aves
Reserve
Baptista et al. 2019 Angola Bicuar National Park Amphibia, Reptilia
Brito et al. 2019 Brazil Catimbau National Park Pentatomoidea
Burton and Lea 2019 | United Monterey Bay National Marine Gnathostomata
States Sanctuary




Authors Country Name of Protected Area Taxonomic group/s
Caviedes et al. 2019 Honduras Blanca Jeannette Kawas Gastropoda
Fernandez National Park and
Cuyamel-Omoa National Park
Conti et al. 2019 Italy Maijella National Park Tracheophyta
Fateryga and Russia Karadag State Nature Reserve Tracheophyta
Fateryga 2019
Friedlander et al. Cuba Clipperton Atoll Marine Protected | Actinopteryagii,
2019 Area Ophiuroidea,
Demospongiae,
Hexactinellida,
Chondrichthyes,
Malacostraca,
Anthozoa, Crinoidea,
Hydrozoa, Scyphozoa,
Asteroidea,
Echinoidea
Gusakov 2019 Russia Eltonsky Nature Park Nematoda, Diptera,
Clitellata, Cyclopoida,
Harpacticoida,
Ostracoda,
Amphipoda,
Hemiptera,
Coleoptera
Hornung-Leoni et al. Mexico Reserva de la Biosfera Barranca Tracheophyta
2019 de Metztitlan
Ledesma et al. 2019 Spain Sierra de Guadarrama National Araneae
Park
Lind and Davies 2019 | South Africa | Kruger National Park Isoptera




Authors Country Name of Protected Area Taxonomic group/s
Nascimento et al. Brazil Saltinho Biological Reserve, Chironomidae
2019 Charles Darwin Ecological
Refuge, Fernando de Noronha
National Park and Wildlife
Reserve of Gurjau
Olmos-Garcia et al. Mexico Parque Nacional Sistema Arrecifal | Gastropoda
2019 Veracruzano
Paz-Rios et al. 2019 Mexico Alacranes Reef National Park Amphipoda
Reyes-Chavez et al. Honduras Rio Platano Man and Biosphere Tracheophyta
2019 Reserve
Rodrigues et al. 2019 | Brazil Lencois Maranhenses National Tracheophyta
Park
Shi et al. 2019 China Multiple Nature Reserves (See Gnathostomata
Shi et al. 2019)
Treitler et al. 2019 Italy Asinara National Park Coleoptera
Tripp and Lendemer United Great Smoky Mountains National | Fungi
2019 States Park
Tu et al. 2019 Vietnam Song Thanh Nature Reserve and | Mammalia
Saola Quang Nam Nature
Reserve
Vega-Pérez et al. Mexico La Malinche National Park Amphibia, Reptilia
2019
Araujo et al. 2020 Brazil The Sete Cidades National Park Anuran
Bum et al. 2020 South Taebaeksan Mountain National Bryophyta
Korea Park
Dippenaar-Schoeman | South Africa | Addo Elephant National Park Araneae
et al. 2020
Egorov et al. 2020 Russia Mordovia State Nature Reserve Coleoptera




Authors

Country

Name of Protected Area

Taxonomic group/s

Fang et al. 2020 China Nanling National Nature Reserve | Phytoseiidae
Hakim et al. 2020 Bangladesh | Lawachara National Park Amphibia, Reptilia
ljaz et al. 2020 Pakistan Musk Deer National Park Fungi
lturriaga et al. 2020 Cuba National Park Desembarco del Aves, Amphibia,
Granma Reptilia,
Kalinina et al. 2020 Russia Polistovskiy State Nature Reserve | Basidiomycota
Kisekelwa et al. 2020 | Democratic | Kahuzi-Biega National Park Gnathostomata
Republic of
the Congo
Lewis 2020 Canada Frontenac Provincial Park Fungi
Longo et al. 2020 Italy Ustica Island Marine Protected Porifera
Area
Marcano and Castillo | Venezuela General Juan Pablo Penaloza Fungi
2020 and Paramos Batallén y La Negra
National Parks
Taylor and Brazil Catimbau National Park Cactaceae
Albuquerque-Lima
2020
Tham et al. 2020 Vietnam Cham Chu and Bac Me Nature Mammalia
Reserves
Araujo and Pinto Brazil Mananciais da Serra Protected Odonata
2021 Area
Araujo et al. 2021 Brazil Caparao National Park Tracheophyta
Bum et al. 2021 South Gayasan Mountain National Park | Bryophyta
Korea
De Oliveira et al. Brazil Floresta Nacional do Tapajos, Tracheophyta

2021

APA Alter do Chao and APA Jua




Authors Country Name of Protected Area Taxonomic group/s
Espinoza-Amén et al. | Ecuador Manglares Churute Ecological Tracheophyta, Aves,
2021 Reserve, Isla Santay National Mammalia, Reptilia,
Recreation Area, Mache-Chindul Amphibia
Ecological Reserve, Islas Corazén
y Fragatas Wildlife Reserve,
Machalilla National Park,
Manglares EI Morro Wildlife
Reserve, Manglares El Salado
Fauna Production Area and
Arenillas Ecological Reserve
Garcia-Morales 2021 | Mexico Reserva de la Biosfera Pantanos | Chiroptera
de Centla
Gheza et al. 2021 Italy Maijella National Park Fungi
Hercos et al. 2021 Brazil Mamiraud Sustainable Gnathostomata
Development Reserve
Kanga et al. 2021 Ivory Coast | Mount Nimba Integrated Nature Anura
Reserve
Meddour and Sahar Algeria Djurdjura National Park Tracheophyta
2021
Polevoi 2021 Russia Kostomuksha State Nature Sciaroidea
Reserve
Sabino et al. 2021 Brazil Porto Ferreira State Park Tracheophyta
Sarker et al. 2021 Bangladesh | Nijhum Dweep National Park Gnathostomata
Silva et al. 2021 Brazil Chapada das Mesas National Bryophyta
Park
Turghan et al. 2021 China Arjin Mountain Nature Reserve Aves
Zhang et al. 2021 China Kalamaili Mountain Ungulate Sarcophagidae
Nature Reserve
Amiri et al. 2022 Iran Zarrin-Kuh Protected Area Tracheophyta,




Authors Country Name of Protected Area Taxonomic group/s
Boudouresque et al. France Port-Cros National Park Rhodophyta,
2022 Tracheophyta,
Charophyta,
Chlorophyta
Da Silva et al. 2022 Brazil The Chapada das Mesas National | Fabaceae
Park
Dubeux et al. 2022 Brazil Estacao Ecologica and Area de Reptilia
Protecao Ambiental de Murici
Jocque and Garrison | Honduras Cusuco National Park Odonata
2022
Laterza et al. 2022 Italy Alta Murgia National Park Pentatomoidea
Ledesma et al. 2022 Spain Sierra de Guadarrama National Cholevinae
Park
Lobodn-Rovira et al. Angola lona National Park Amphibia, Reptilia
2022
Machado et al. 2022 Brazil Cagarras Islands Natural Gnathostomata
Monument
Marcusso et al. 2022 | Brazil Augusto Ruschi Biological Tracheophyta
Reserve
Miranda et al. 2022 Brazil State Park of Itaunas Angiospermae
Monteiro et al. 2022 Angola Quicama National Park Tracheophyta
Queiroz et al. 2022 Brazil Protecao Ambiental do Rio Formicidae
Pandeiros
Renner and Day 2022 | United Lake Mead National Recreation Haptophyta,
States Area Angiospermae,
Amphibia, Bivaliva,
Osteichthyes, Reptilia
Santos et al. 2022 Brazil Serra dos Orgaos National Park Trichoptera




Authors Country Name of Protected Area Taxonomic group/s
Silva et al. 2022 Brazil Sempre Vivas National Park Lepidoptera
Singh et al. 2022 India Great Himalayan National Park Lepidoptera
Trovo and Brazil Chapada dos Veadeiros National | Eriocaulaceae
Echternacht 2022 Park
Varona-Alvarez 2022 | Cuba Alejandro de Humboldt National Rhopalocera
Park
Walters et al. 2022 Gabon Parc National des Plateaux Tracheophyta
Bateke
Winfield et al. 2022 Mexico Protected Area Tuxpan-Lobos Amphipoda
Yaqgoob et al. 2022 India Dachigam National Park Tracheophyta
Zhang et al. 2022 China Nature Reserves in Qinling-Daba | Tracheophyta
Mountains (see Zhang et al.
2022)
Abwe et al. 2023 Democratic | Kundelungu National Park Gnathostomata
Republic of
the Congo
Arabuli et al. 2023 United Machakhela National Park Oribatid mites
States
Bell-Doyon 2023 Canada Mingan Archipelago National Park | Fungi
Reserve
Cruz-Elizalde et al. Mexico Sierra Gorda de Queretaro Amphibia, Reptilia
2023 Biosphere Reserve
Ferreira et al. 2023 Brazil Serra do Divisor National Park, Insecta
Chandless State Park, Humaita
Forest Reserve and Chico
Mendes Environmental Park
Friedrich 2023 Peru ACP Panguana Oribatid mites
Islam et al. 2023 India Overa-Aru wildlife sanctuary Tracheophyta




al. 2024*

Protected Area

Authors Country Name of Protected Area Taxonomic group/s
Karin et al. 2023 Indonesia Gunung Dako Nature Reserve Amphibia, Reptilia
Liu et al. 2023 China Dabie Mountains Basidiomycota
Manda et al. 2023 Democratic | Upemba National Park Actinopterygii
Republic of
Congo
Marques et al. 2023 Brazil Serra das Confusdes National Amphibia, Reptilia
Park
Martinez-Servin et al. | Mexico Puerto Morelos Reef National Actinopterygii
2023 Park
Rodrigues and Brazil Aiuaba Ecological Station, Hemiptera
Moreira 2023 Chapada Diamantina National
Park, Catimbau National Park and
Serra das Confusées National
Park
Schwarz et al. 2023 Ivory Coast | Comoé National Park Mantodea
Sheik and Weeks United Shenandoah River State Park Tracheophyta
2023 States
Winfield et al. 2023 Mexico Coral Reef Puerto Morelos Amphipoda
National Park and Coral Reef
Sian Ka’an Biosphere Reserve
De Ledn-Pesqueira et | Mexico Médanos de Samalayuca Natural | Tracheophyta

*published online in 2023. Included in 2023 data for the study.
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Appendix S3. Decision tree for allocating basis of record for 210 peer-reviewed articles.
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* If museum or herbarium codes and/or collection codes were provided for specimens that were
previously collected then basis of record was also used.

** Audio recording was only considered to have taken place if the device for recording was
mentioned, or it was very clear that audio was taped. i.e. there was no ambiguity that recording calls

referred noting calls that were heard.



Appendix S4. List of Global Biodiversity Information Facility (GBIF) checklist datasets that were

evaluated. Arranged alphabetically by country, then protected area, then taxonomic groups.

* The alien species lists mentioned many groups, not all of which were included on the lists.

Country Name of Protected Area Taxonomic Group/s
Algeria Djurdjura National Park Arachnida
Algeria Théniet El Had National Park Arachnida
Angola :;)gs]ic';:ljlior\;]:tlufjlr;:rnkd Namibe Amphibia, Reptilia
Angola Quigama National Park Tracheophyta
Argentina Iguazu National Park Insecta
Argentina Los Cardones National Park Mammalia
Belarus Belovezhskaya pushcha National Park Insecta
Belarus Berezinsky Biosphere Reserve Insecta
Bhutan Toorsa Strict Nature Reserve Tracheophyta
Brazil Catimbau National Park Insecta
Brazil Chapada dos Veadeiros National Park Tracheophyta
Brazil Guartela State Park Insecta
Brazil Iguacu National Park Insecta
Brazil Itacolomi State Park Tracheophyta
Brazil Itacolomi State Park Tracheophyta
Brazil Itacolomi State Park Tracheophyta
Brazil Itacolomi State Park Tracheophyta
Brazil Itacolomi State Park Tracheophyta
Brazil Itacolomi State Park Tracheophyta
Brazil Itacolomi State Park Tracheophyta
Brazil Itacolomi State Park Tracheophyta
Brazil Itacolomi State Park Tracheophyta
Brazil Itacolomi State Park Tracheophyta
Brazil Itacolomi State Park Tracheophyta
Brazil Itacolomi State Park Tracheophyta
Brazil Itacolomi State Park Tracheophyta
Brazil Rio Doce State Park Insecta
Brazil Serra do Intendente State Park Insecta
Brazil Upajara (Cgar? State) anq Sete Insecta
Cidades (Piaui State) National Parks
Brazil and Argentina Iguacu and Iguazu National Parks Tracheophyta
Brunei Ulu Temburong National Park Insecta




Country Name of Protected Area Taxonomic Group/s
Tracheophyta, Ascomycota,
Cambodia Keo Seima Wildlife Sanctuary BaS|d|_omycota, Actinopterygii,
Amphibia, Aves, Insecta,
Mammalia, Reptilia
Cambodia Phnom Tbaeng Natural Heritage Park Tracheophyta, Aves, Mammalia
Judith River Formation of dinosaur
Canada Provincial Park Therapoda
Canada Tursujuq National Park Ochrophyta
Central African Protected Areas of Central African
. ) Insecta
Republic Republic
Central African
Republic, Cameroon Sangha Trinational Protected Area Insecta
and Congo-Brazzaville
China Damingshan National Natural Reserve Arachnida
China Gaoligongshan National Nature Tracheophyta
Reserve
China Hailuogou Glacier Area Insecta
China Huanglong National Nature Reserve Insecta
China Jinggang Mountain National Nature Arachnida
Reserve
China Jinggang Mountain National Nature Arachnida
Reserve
China Jinggangshan National Nature Reserve | Arachnida
China Nanling PI'.IOI‘Ity Area for Biodiversity Insecta
Conservation
China Wulipo National Nature Reserve Arachnida
China Wuyi Mountain National Nature Insecta
Reserve
China Yintiaoling National Natural Reserve Diplopoda
Colombia Protected Areas in Colombia Arachnida
Colombia Protected Areas in Colombia Insecta
Colombia Seaflower Biosphere Reserve Actinopterygii, Chondrichthyes




Country

Name of Protected Area

Taxonomic Group/s

Asteroidea, Crinoidea,

Colombia Seaflower Biosphere Reserve Echinoidea, Holothuroidea,
Ophiuroidea
Croatia Plitvice Lakes National Park Insecta
Ecuador Jardin de los Suefios Reserve Aves
*Alien species (Animalia,
Eswatini Hawane Nature Reserve and Dam Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
*Alien species (Animalia,
Eswatini Malalotja Nature Reserve Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
*Alien species (Animalia,
Eswatini Matenga Nature Reserve Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
*Alien species (Animalia,
Eswatini Mlawula Nature Reserve Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
Kafa Biosphere Reserve, Bale
Ethiopia Mountains National Park and other Insecta
areas of conservation interest
Gabon Monts Birougou National Park Insecta
Gabon Moukalaba National Park Insecta
Ghana Atewa Range Forest Reserve Basidiomycota
Ghana Atewa Range Forest Reserve Insecta
Ghana Atewa Range Forest Reserve Tracheophyta
Ghana Bia Conservation Area Basidiomycota
Ghana Bia North Tributaries Forest Reserve Tracheophyta
Ghana Bonsa River Forest Reserve Tracheophyta
Ghana Forest Reserves in Ghana Tracheophyta
Ghana Mole National Park Mammalia, Reptilia
Honduras Cusuco National Park Insecta
India Dumna Nature Park Insecta
India Kangchendzonga Biosphere Reserve Tracheophyta
India Kaziranga National Park Enoplea
India Mahananda Wildlife Sanctuary Tracheophyta
India Namdapha National Park and Tiger Arachnida
Reserve
India INat_lonal Wildlife Refuges in Southern Insecta, Astacidea, Fish
ndiana
India Neora Valley National Park Insecta
India Neora Valley National Park Tracheophyta
India Senchal Wildlife Sanctuary Tracheophyta




Country

Name of Protected Area

Taxonomic Group/s

India Silent Valley National Park Nematoda
India Singhalila National Park Tracheophyta
Indonesia Lake Kalimpa’al Lore Lindu National Amphibia
Park
Indonesia Sebangau National Park Mammalia
Italy Alta Murgia National Park Insecta
Italy Forestle Casen_tinesi, Monte Falterona e Insecta
Campigna National Park
Italy Marine Protected Area Isole Ciclopi Chlorophyta, Rhodophyta
Italy Marittime Nature Park Mammalia
Italy Monviso Natural Park Insecta
Italy Protected Area of Rome Arachnida
Italy Val Grande National Park Insecta
Italy Foreste Casentinesi National Park Mammalia
Ivory Coast Comoé National Park Insecta
Kazakhstan Ulytau State National Natural Park Tracheophyta
Kazakhstan State National Natural Park Buiratau Tracheophyta
Kenya A Rocha Dakatcha Nature Reserve Insecta
Kenya A Rocha Dakatcha Nature Reserve Mammalia
Kenya A Rocha Dakatcha Nature Reserve Tracheophyta
Kenya A Rocha Dakatcha Nature Reserve and Aves
its Surrounding Area
Kenya Sibiloi National Park Amphibia, Reptilia
Madagascar Montagne d’Ambre National Park Arachnida
Malaysian Borneo Tawau Hills Park Aves
Mexico Barranca del Cupatitzio National Park Insecta
Mexico White Sands National Monument Insecta
*Alien species (Animalia,
Mozambique Bazaruto National Park Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
Mozambique Bazaruto National Park Insecta
Nepal Api Nampa Conservation Area Tracheophyta, Aves, Insecta
Nepal Kangchenjunga Conservation Area Tracheophyta
*Alien species (Animalia,
Niue Huvalu Conservation Area Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
Pakistan Margalla Hills National Park Qgﬁ?ﬂ‘gﬁgﬂgéﬂgmb'a’ Aves,
Panama Coiba National Park Arachnida
Panama Panama’s National Parks Insecta
Poland Ojcow National Park Insecta
Poland Swietokrzyski National Park Insecta
Russia Kaluzhskie Zaseki Nature Reserve Insecta
Russia Kondinskie lakes Natural Park ﬁxqe;r,]ilt\)/:Z,ran;e;)liﬁi,aActinopterygii,
Russia Kondinskie lakes Natural Park Bryophyta




Country

Name of Protected Area

Taxonomic Group/s

Russia Kondinskie lakes Natural Park Fungi

Russia Kondinskie lakes Natural Park Tracheophyta
Cyclostomata, Fish, Amphibians,

Russia Kurilsky Nature Reserve Reptilia, Aves, Mammalia,
Invertebrates

Russia Kurilsky Nature Reserve Tracheop hyta, Bryophyta, Algae,
Fungi, Lichen

Russia Noomto Natural Park Tracheophyta

Russia Oleniy Nature Park Tracheophyta

Russia Onega Pomorie National Park Fungi

Russia Prioksko-Terrasny reserve Mammalia

Russia Prioksko-Terrasnyi Biosphere Reserve Bryophyta

Russia Prioksko-Terrasnyi Biosphere Reserve Tracheophyta

Russia Shorsky National Park Bryophyta

Russia \éISImSky State Natural Biosphere Tracheophyta

eserve

Russia Voronezhsky Biosphere Reserve Tracheophyta

Russia Yuganskiy Nature Reserve Amph!bla, Aves, Mammalia,
Reptilia

Russia Yugyd Va National Park Bryophyta

Saudi Arabia Rawdhat Khorim National Park Insecta
*Alien species (Animalia,

Seychelles Aride Special Reserve Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
*Alien species (Animalia,

Seychelles Cousin Special Reserve Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
*Alien species (Animalia,

Seychelles Curieuse Special Reserve Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
*Alien species (Animalia,

Seychelles lle-aux-Vaches Nature Reserve Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
*Alien species (Animalia,

Seychelles Morne-Seychellois National Park Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
*Alien species (Animalia,

Seychelles Praslin National Park Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
*Alien species (Animalia,

Seychelles Recif Special Reserve Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
*Alien species (Animalia,

Seychelles Silhouette National Park Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
*Alien species (Animalia,

Seychelles Vallée de Mai Nature Reserve Bacteria, Chromista, Fungi,

Plantae, Protozoa, Viruses)

South Africa

Addo-Elephant National Park

*Alien species (Animalia,
Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)




Country

Name of Protected Area

Taxonomic Group/s

South Africa

Agulhas National Park

*Alien species (Animalia,
Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)

South Africa

Augrabies Falls National Park

*Alien species (Animalia,
Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)

South Africa

Bontebok National Park

*Alien species (Animalia,
Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)

South Africa

Camdeboo National Park

*Alien species (Animalia,
Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)

South Africa

Garden Route National Park

*Alien species (Animalia,
Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)

South Africa

Garden Route National Park

Insecta

South Africa

Golden Gate Highlands National Park

*Alien species (Animalia,
Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)

South Africa

iSimangaliso Wetland Park

Chaetonotida

South Africa

iSimangaliso Wetland Park

Porifera

South Africa

Kalahari Gemsbok National Park

*Alien species (Animalia,
Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)

South Africa

Karoo National Park

*Alien species (Animalia,
Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)

South Africa

Kruger National Park

*Alien species (Animalia,
Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)

South Africa

Mapungupwe National Park

*Alien species (Animalia,
Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)

South Africa

Marakele National Park

*Alien species (Animalia,
Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)

South Africa

Mokala National Park

*Alien species (Animalia,
Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)

South Africa

Mountain Zebra National Park

*Alien species (Animalia,
Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)

South Africa

Namaqua National Park

*Alien species (Animalia,
Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)

South Africa

Richtersveld National Park

*Alien species (Animalia,
Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)

South Africa

Table Mountain National Park

*Alien species (Animalia,
Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)

South Africa

Tankwa-Karoo National Park

*Alien species (Animalia,
Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)




Country

Name of Protected Area

Taxonomic Group/s

South Africa

Verloren Valei Nature Reserve

*Alien species (Animalia,
Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)

South Africa

West Coast National Park

*Alien species (Animalia,
Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)

Spain El Cachucho Marine Protected Area Malacostraca
Spain Mediterranean Natural Parks Insecta
Spain Sierra de Guadarrama National Park Insecta
Spain Spanish National Parks Arachnida
Tracheophyta, Aves, Insecta,
Sweden Sweden Ascomycota, Mammalia,
Arachnida
Switzerland Swiss National Park Nematoda
Switzerland Swiss National Park Nematoda
. . - Tracheophyta, Mammalia,
Taiwan I\R/hee;Shga and Huaping Islets Wildlife Reptilia, Insecta, Aves,
9 Chondrichthyes, Osteichthytes
Taiwan Taijiang National Park Mollusca
*Alien species (Animalia,
Tanzania Amani Forest Nature Reserve Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
Tanzania Kimboza Forest Reserve Insecta
*Alien species (Animalia,
Tanzania Ngorongoro Biosphere Reserve Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
*Alien species (Animalia,
Tanzania Serengeti National Park Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
Thailand Doi Suthep-Pui National Park Insecta
*Alien species (Animalia,
Tonga Protected Areas of Tonga Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
Turkey D|ng Peninsula-Buyuk Menderes Delta Arachnida
National Park
Turkey Kazdagi National Park Insecta
Uganda Bukaleba Forest Reserve Mammalia
Uganda Igwe-Luvunya Forest Reserve Tracheophyta
Uganda Mabira Central Forest Reserve Mammalia
Uganda Mpanga Forest Reserve Mammalia
Uganda Mpigi Forest Reserve Mammalia
*Alien species (Animalia,
Uganda Murchison Falls National Park Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
*Alien species (Animalia,
Uganda Queen Elizabeth National Park Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
Uganda West-Bugwe Forest Reserve Mammalia
Uganda West-Bugwe Forest Reserve Tracheophyta
Uganda Zika Forest Reserve Mammalia




Country

Name of Protected Area

Taxonomic Group/s

Ukraine Dvorichanskyi National Nature Park Amphibia

Ukraine Dvorichanskyi National Nature Park Insecta

Ukraine Kinburnska Kosa Landscape Park Tracheophyta

Ukraine Luhansk Nature Reserve of NASU Tracheophyta

Ukraine National Nature Park Kamianska Sich Tracheophyta

Ukraine Oleksandrivskyi Landscape Reserve Tracheophyta

Ukraine Pyriatynskyi National Nature Park Actinopterygii

Ukraine Pyriatynskyi National Nature Park Zooplankton

Ukraine Sahy Landscape Reserve Tracheophyta

Ukraine Shyroka Balka Botanical Reserve Tracheophyta

Ukraine Slobozhanskyi National Nature Park Amphibia

Ukraine Slobozhanskyi National Nature Park Mammalia

Ukraine Slobozhanskyi National Nature Park Reptilia

Ukraine Sofiivskyi Botanical Reserve Tracheophyta

Ukraine Stanislavskyi Landscape Reserve Tracheophyta

Ukraine Valley of Kurgans Park Tracheophyta

United States Mammoth Cave National Park Chondrichthyes

United States ﬁg?kusma and Kings Canyon National Diplopoda

United States of Carmel Pinnacles Marine Protected .

: Porifera
America Area
United States of Flower Garden Banks National Marine .
: Porifera

America Sanctuary

Unlteq States of Great Smoky Mountains National Park Diplopoda

America

Unlteq States of Great Smoky Mountains National Park Insecta

America

Unlteq States of Great Smoky Mountains National Park Insecta

America

Unlteq States of Great Smoky Mountains National Park Insecta

America

Unlteq States of Great Smoky Mountains National Park Insecta, Arachnida

America

Unlteq States of Great Smoky Mountains National Park Tardigrada

America

Uzbekistan Chatkal State Biosphere Reserve Tracheophyta

Vietnam Bach Ma National Park Insecta
*Alien species (Animalia,

Zimbabwe Chimanimani National Park Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)
*Alien species (Animalia,

Zimbabwe Nyanga National Park Bacteria, Chromista, Fungi,
Plantae, Protozoa, Viruses)

Zimbabwe Protected Areas of Zimbabwe Arachnida

Zimbabwe Protected Areas of Zimbabwe Reptilia
*Alien species (Animalia,

Zimbabwe Victoria Falls National Park Bacteria, Chromista, Fungi,

Plantae, Protozoa, Viruses)




Appendix S5. Proposed guidelines for developing species checklists for protected areas.

During the process of researching checklists and developing checklists for South Africa’s national
parks, we have developed guidelines for the checklist creation process, which includes collecting
occurrence data, assigning accepted names, compiling a checklist from multiple sources and adding
additional information to the list. These guidelines are primarily directed at the development of species

checklists for protected areas and not necessarily the publication of checklists in journal articles.

The first step is to collate occurrence data from different sources. Once this is done, the occurrence
data needs to be put into the same format e.g. columns in the same order in MS Excel, which is
commonly used by protected area staff. After this, accepted names should be assigned to each
occurrence record. The GBIF species lookup tool can be useful for this step. However, checks need
to be made that matching is accurate and at the correct taxonomic level, as the GBIF species name
matching tool sometimes matches to higher taxonomic ranks. A checklist can then be created for the
accepted names and their associated synonyms for which there is occurrence data and/or a record of
the sources used to include each taxon. This list should be checked for inaccurate names that could
be the result of misidentification e.g., in iNaturalist. A more comprehensive approach would be to
validate all the occurrence records before creating the final checklist, but protected area staff don’t
always have capacity to do this. Including the information source for listed species is critical for users
to judge the information accuracy of checklists. For example, a species merely being listed on a
previous checklist without an indication of the sources used to develop that checklist does not provide
confidence that the species is present, whereas verifiable specimen collections or direct observations
across multiple sources provide a more reliable indication of occurrence. As such, tracking all the
sources that identify a particular species in a particular area is an important step in the validation of
checklists. Once the final list of names has been created, additional information can be included, such
as IUCN Red List status, level of endemism and year of most recent record. Such data is useful for
prioritising monitoring and decision making. A database of relevant information for species can be
kept so that it is easy to associate it with names in a checklist using R or functions in MS Excel, which

is commonly used by protected area staff.



1. Creating checklists

A consistent and standardised approach should be used for the compilation of species checklists. One
vital aspect is choosing and specifying the taxonomic backbone that is being used.

The proposed checklist creation
process

The checklist creation process has four
main steps:

1. Occurrence record data needs
to be obtained from all
available sources and put into
the same format.

2. Accepted names need to be
assigned to all occurrence
records following a particular
taxonomic backbone. One way
of doing this is by using the
accepted name from GBIF.
However, other relevant
taxonomic backbones can also
be used.

3. A checklist needs to be made
of accepted names and their
associated synonyms for which
there is occurrence data.

4. Additional information can be

o TIDY DATA
——

OBTAIN AND

PROCESS
OCCURRENCE
DATA

1.SEARCH for data
2.EXTRACT data
3.COMBINE data

ensure every observation is on its own row

@ TAXON ID AND STATUS
ASSIGN

ACCEPTED
NAMES

4. Get GBIF TAXON ID, name, status

use the GBIF species lookup tool

5. Get GBIF ACCEPTED NAMES

use INDEX and MATCH functions in MS Excel or r code

CREATE 6 CREATE CHECKLIST

CHECKLIST OF
ACCEPTED
NAMES

6. Create CHECKLIST of ACCEPTED
NAMES with SOURCES

use r code or pivot table, sort, autofill, concatenate etc. in MS Excel

7. Add SYNONYMS with observations

use INDEX and MATCH functions in MS Excel or r code

ADD 9 ADD RELEVANT INFO

CONSERVATION

8. Add CONSERVATION STATUS
9. Add anything else e.g. most

recent year recorded (max year)
use INDEX and MATCH functions in MS Excel or r code

STATUS ETC.

included, such as IUCN Red List status and year of most recent record.

The first step in creating a species checklist is to obtain occurrence record data from all available

sources. These sources include but are not limited to the following:

P> Protected area checklists from park staff and ecologists

Research projects conducted by researchers from universities

Scientific publications and reports

Protected area management plans, lower-level plans, state of knowledge reports
Protected area herbarium and museum data

Survey data using different approaches, such as seine nets and Sherman traps

vV v v v v Y

Mammal census data, including aerial and road counts



BRUV (Baited Remote Underwater Video) data
Camera trap data

Monitoring data

Data in national databases

Data on protected area staff computers

Existing protected area databases

GBIF (Global Biodiversity Information Facility)
iNaturalist, including park lists without coordinates

Park staff and taxon experts

vV Vv vV VvV vV v v Vv Y

Ranger patrol data (e.g. CyberTracker, EarthRanger and Spatial Monitoring and Reporting

Tool)

The second step of the checklist creation process involves assigning accepted names to all observation
records while retaining the verbatim name. Accepted names from a standardised, recognised
taxonomic backbone need to be used for names in your checklist. The verbatim names that are reported
in sources are not necessarily the names that appear in the checklist. However, synonyms can be
included with accepted names. It is important to note that some sources do not record the appropriate
name. e.g. some records in iNaturalist may record the wrong name. For example, there may only be a
particular subspecies that is found in a park, but some records are at the species level. The final list will
just include the subspecies name with the assumption that the observation records for the taxon are

the subspecies and the recorded e.g. user of iNaturalist was not aware of this.

The third step of the process is creating a list that only includes the appropriate accepted names, i.e.
accepted names from a particular taxonomic backbone, such as GBIF, that have been checked to retain
the appropriate names and exclude names that have been recorded in error. For example, iNaturalist
users may have selected the name of a monkey or antelope that does not occur in the country or

selected a species name when it is a subspecies that is known to occur in a protected area.



The final step of the process is to append relevant information, such as Red List status and CITES
listing. Species occurrence status information, such as whether a species is endemic, often needs to

be compiled from relevant literature.

2.1 Collating occurrence data

The first step of collating relevant occurrence data requires conducting literature searches and obtaining

data from other protected area staff members.

2.1.1 Getting data from GBIF"

GBIF data can be downloaded for Protected Areas from the GBIF website by specifying the most
southerly, northerly, easterly and westerly coordinates of a bounding box that is larger than the park
(also see Supplementary material of Spear et al. 2023"). Park boundary polygons can then be used to
determine which points are in a protected area using the intersection function in QGIS. Data can also
be downloaded from GBIF using the R package rgbif (see
https://cran.rproject.org/web/packages/rgbif/index.html) and using GBIF’s API (see
https://www.gbif.org/developer/occurrence). Also see https://data-blog.gbif.org/post/downloading-
longspecies-lists-on-gbif/ for guidelines on how to download GBIF occurrence data using R and

Python. Additionally, there is a GBIF occurrences plugin for QGIS. To use the plugin, Open QGIS and

click Plugins > Manage and install plugins > Type GBIF into the search bar and select and install the
GBIF occurrences plugin. Click Vector > GBIF occurrences.

! Spear, D., van Wilgen, N.J., Rebelo, A.G., & Botha, J.M. 2023. Collating biodiversity occurrence data for
conservation. Frontiers in Ecology and Evolution, 11, 1037282.



Collate tidy occurrence data

Find publications, protected area management plans, checklists
from park staff or ecologists, monitoring, census & survey data,
incl. BRUV and camera traps, birder checklists, data from
partners/researchers, protected area databases, herbarium
data, online databases, and GBIF.

o Extract data from different sources into MS Excel.

¢ Use verbatim name as per source.

o Add field with source name. Use dataset name for GBIF.
e Add protected area name.

e For each set of raw data, make a version with columns in
the same order including verbatim name and source.

» Select, copy and paste each set of data into the same
spreadsheet with verbatim name and source.

e Ensure Tidy Data: every observation in its own row.

e There is a QGIS plug-in and other guidelines for
downloading GBIF data for parks.
= e Use the table of dataset keys and names or
° follow guidelines to find these on GBIF.
Tl pS e Use Ctrl+G and Ctrl+Shift+arrows to select data.

Data that are downloaded from GBIF include a dataset key, but they often don’t include relevant detail
about the dataset. The name of the dataset that each observation record originated from can be
obtained using the dataset key. A table of dataset keys and dataset names has been compiled to

easily allocate the dataset names using INDEX and MATCH functions in MS Excel.

What is Tidy Data?

Each row is one observation. ® Each column is a variable. ¢ Each cell is a single value.

2.1.2 Getting data from pdfs

Data copied from pdfs does not always copy to MS Excel in the format that is needed. Sometimes the
data in each row will paste as one sentence and not in different columns. There are a few different
tools in MS Excel that can be used to help with getting the data into the required columns. Text to

columns sometimes works. Before using text to columns, copy and paste the column of text to a new



column and then use the copy for editing using different approaches. Something that can be useful to
use in association with text to columns is replacing a particular recuring text string that separates
different variables with a character, such as $. This character can then be used to separate the text
into different columns using text to columns. A very useful tool to try is Flash Fill. Flash Fill will
automatically fill in data if it can pick up a pattern. You will need to check that the data has been filled
correctly. You may need to change some of the data and redo the Flash Fill or make sure that you
have covered enough examples for the Flash Fill to automatically fill in the relevant data in the
relevant columns. You might be able to use Flash Fill for some of the data but not all of it. Also, bear
in mind that you don’t need to extract all the information from a table in a pdf. It might be sufficient to
extract just the names or the names and one or two other columns. Information such as Red List
status can be obtained later in the process using up to date data. Another tool that can sometimes be
useful for extracting data from a text string is using a combination of the IF and FIND functions or
other similar functions to return particular text if particular text is found in the text string. For example,
if you have a column where you want to pull out the terms endemic, alien and indigenous and
extralimital, then you could use a formula like:
B1=IFERROR(IF(FIND("alien",A1)>0,"alien"),IFERROR(IF(FIND("endemic",A1)>0,"endemic"),IFERR

OR(IF(FIND("indigenous",A1)>0,"indigenous"),IF(FIND("extralimital",A1)>0,"extralimital"))))

Pdfs of scanned papers and reports are problematic as their contents cannot be copied and pasted.
There are online tools that can be used to convert pdf images to text using optical character

recognition (OCR). These can be found by searching “convert pdf image to text’.

2.1.3 Standardising data fields and formats

A standardised approach for collating data needs to be used. You can create MS Excel spreadsheets
for the data that has been copied from pdfs including all fields in the order they were in the source.
Then, you can create MS Excel spreadsheets where you have the information in a specific order. For
example, your first four columns might be Source detail, Source type, National Park, Verbatim name.
If you create a different spreadsheet for each source, then create a spreadsheet that has the data in
the same order in different spreadsheets for different sources, as all data sources will need to be

combined.



2.2 Assign accepted names

After all relevant occurrence data are collated, accepted names need to be assigned by matching
verbatim names with a relevant taxonomic backbone. It is very important to keep a record of the
verbatim names from the different sources. The accepted name is allocated in a separate column.
First, create a list of names that can be uploaded to GBIF to match with GBIF names and return GBIF
taxon keys, names, taxonomic status. A csv file is required with a column of scientific names with the
heading scientificName and ideally a kingdom column with the kingdom specified. Guidelines are
provided on the webpage of the species look up tool. Although GBIF may not be the final taxonomic
backbone that you use for your species checklist, the GBIF species lookup tool is useful in picking up
some typos. After obtaining GBIF names and taxon keys they can be used for matching with other
taxonomic backbones, such as the South African National Plant Checklist. Names from the World
Register of Marine Species (WoRMS) are often used for standardising the names of marine species.
WoRMS is incorporated into the GBIF taxonomic backbone along with the Catalogue of Life Checklist

and the World Checklist of Vascular Plants.

Two useful approaches to matching names include having a ‘friendly’ version of the scientific name
for your verbatim names and the list of names that you are trying to match to. i.e. scientific name
without authors and the second useful tool is to use INDEX and MATCH functions in MS Excel (see
Supplementary Material of Spear et al. 20232). | have also created a version of the SANPC that is
matched to GBIF. i.e. matching can be done using the GBIF taxon key. However, you need to check
whether matching is at the same level. i.e. whether GBIF has matched a subspecies at the species
level. The best way to match to the SANPC is using name without authors. This can also be obtained

using TNRS.

2 Spear, D., van Wilgen, N.J., Rebelo, A.G., & Botha, J.M. 2023. Collating biodiversity occurrence data for
conservation. Frontiers in Ecology and Evolution, 11, 1037282.



Assign accepted names

For plants, copy list of names into the TNRS to get scientific
name without authors to use for name matching.

Alternatively, use the GBIF species lookup tool to get canonical
name or create own name without authors.

Create a csv file with names and heading scientificName.
Upload the csv file to the GBIF Species Matching Tool to get
GBIF scientific names.

Open the matched file using Data -> From Text/CSV in an MS
Excel sheet and check for matches at higher rank.

For plants, Use INDEX-MATCH function to bring in accepted
names and taxon status from taxonomic backbone using the
taxon key as unique identifier across sheets OR use an R-Script
If taxon status says SYNONYM, add that name into a synonyms
column.

» Ensure correct format of CSV file for GBIF to match
correctly using the GBIF Species Lookup Tool

2.3 Create a checklist with sources

Ideally, before creating a checklist, the validity of all the data records should be checked. As this often
isn’t possible because of time constraints, providing a record of the source of occurrence records
provides an indication of the reliability and likelihood of an occurrence being accurate. A list of all of the
data sources for each accepted name can be created by using the r code that has been developed or
by creating a pivot table of accepted species names and sources. To create a pivot table, you can add
a column of 1s to use for in the pivot table or use another third column. It is also important to have a
record of the verbatim names that have been used in sources and list them as synonyms. This enables
tracking of the origin of names on the list. Remember to check the final list of names for errors and
correct these. If there is only a subspecies in the park, use the subspecies name only and not the

species name. If an iNaturalist user used a name for something elsewhere, change to the correct name.



Create Checklist

Use R code or

* Create a Pivot table of accepted names and sources.

Sort by sources and copy down source names where values.
Concatenate using =CONCATENATE(SOURCE1,", ",S2)

(]

Use TRIM and FIND and REPLACE to remove extra commas.

o Filter taxonomic status for synonyms and create a sheet.
with synonyms (verbatim name) and accepted names.

¢ Remove duplicate synonyms (verbatim names).

FILTER e There will be some repeated Accepted names.

e Match synonyms to pivoted checklist using accepted names.

e Check for multiple synonyms to be added. i.e. where
accepted name repeated in list of synonyms.

e To save space in final list, you can concatenate synonyms
and accepted names column with = as a separator.

_ _ « R code can be used for this step.
7 \ » Abbreviate source names to save space in the
final checklist.
e Check the final list of names for errors. iNat
TI ps users sometimes get names wrong.

Once the pivot table has been created, sort by each source and copy down the source name for
wherever there is a value (record for the source). You can double click in the corner of the cell to copy
down the source name to everywhere there is a number. Check that this has happened correctly. Then,
use the CONCATENATE function to concatenate sources, e.g. CONCATENATE(A2,", ”,B2,, 7,C2).
Remove additional commas and spaces using TRIM, SORT, FIND and REPLACE functions. To add
synonyms to your list of accepted names, you can take the names that are synonyms into a sheet and
do a lookup (INDEX+MATCH) against the accepted name to pull through synonyms. To create the list
of synonyms, you can sort the full list of names by the taxonomic status column. For plants, use the
SANPC taxonomic status. Copy across the verbatim name (or another column of synonyms with the
corrected version of verbatim name e.g. full name in SANPC or on GBIF for verbatim name) and
accepted name columns for synonyms. Remove duplicate verbatim names from the list of synonyms
and remember to check for multiple synonyms. You can sort by the accepted name column and use

the formula =B3=B2 to find repeated accepted names. Check that the names used as synonyms are



spelt correctly etc. CONCATENATE can be used to combine the accepted names and synonyms into
the final checklist to save space. Ideally, checklist names should be checked by someone who knows

what is in the park.

R code can be used to conduct this process quickly, consistently and with fewer errors.

An example of R code used to create a checklist for a protected area

#load your libraries
library(tidyverse)

library(readxl)
library(dplyr)
library(tidyr)
library(knitr)
library(kableExtra)

#remove NAs from synonym column without removing whole row
PA_clean <- PA %>%
mutate(synonyms = replace_na(synonyms, ""))

# Combine species name and synonyms
PA_syn <- PA_clean %>%
group_by(acc_name) %>% #pivots on the accepted name column

mutate(synonyms = ifelse(any(synonyms !=""),
paste(acc_name, "=", paste(synonyms, collapse =" ")),
acc_name))

kable(PA_syn, "html") %>%
kable_styling()

# Pivot to get unique sources
result <- PA_syn %>%
distinct(acc_name, Source, .keep_all = TRUE) %>%
group_by(acc_name) %>%
summarise(
synonyms = first(synonyms),
Sources = paste(unique(Source), collapse =", "),
TaxonKey = first(gbif_taxon_key)

2.4 Add conservation status and other relevant information

Any information that you want to include in your checklist can be added using the INDEX and MATCH
functions. Recommended annotations for checklists include IUCN Red List status, CITES, occurrence
status, and most recent year recorded. To save space in the final word version of the checklist, the
CONCATENATE function can be used to list different conservation statuses in the same column.
Remember to add full descriptions of any abbreviations used. A database has been created for plants

and animals that includes IUCN Red List, CITES, sensitive species and other relevant information.




Example extract of a plant checklist for a protected area

Scientific Name Source Occurrence Threat Status
Status

Abutilon sonneratianum (Cav.) Sweet iNat, KSAN, Palmer 1989 indig LC

Adromischus sphenophyllus C.A.Sm. iNat indig; end LC

Adromischus triflorus (L.f.) A.Berger KSAN, Palmer 1989 LC, Sensitive

Agave sisalana Perrine Masubelele et al. 2009 notindig; nat | NE

Aizoon rigidum L.f. = Aizoon rigidum KSAN, Palmer 1989 indig LC

L.f. var. angustifolium Sond.

Aloe ferox Mill. iNat, KSAN, Obs.org, Palmer indig LC, CITES Il
1989

Source descriptions:

KSAN: Kimberley South African National Parks Herbarium; iNat: iNaturalist; Obs.org: Observation.org
Masubelele, M.L., Foxcroft, L.C. & Milton, S.J., 2009, ‘Alien plant species list and distribution for Camdeboo
National Park, Eastern Cape Province, South Africa’, Koedoe: African Protected Area Conservation and Science
51(1), 80-89.

Palmer, A.R,. 1989, ‘The vegetation of the Karoo Nature Reserve, Cape Province. 1. A phytosociological

reconnaissance’, South African Journal of Botany 55(2), 215-230.

Occurrence status:

end: endemic to the province; indig: indigenous; notindig: not indigenous; nat: naturalized

Threat status descriptions:
South African Red List status: LC - Least Concern; NE — Not Evaluated
CITES Supporting Information Il includes species that are not currently threatened with extinction but may

become so without trade controls.



